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Course outline: Day 1

9:00 -9:30 Session 1a Introduction to Mangrove Forest and
9:30-10:00 Session 1b Radar Remote Sensing
10:00 — 10h30 Photo Session/Tea Break

10:30 - 11:00 Session 2a Sources of Radar Remote Sensing Data
11:00 — 12:30 Session 2b Process radar images
12:30 — 14:00 Lunch Break

14:00 - 15:00 Session 2c Data processing in QGIS

15:00 - 16:00 Session 3a Biomass estimation

16:00 - 16:15 Tea/Coffee Break



Course outline: Day 2

09:00 -10:00 Session 3b Biomass estimation

10:00 —10:30 Tea/Coffee Break

10:30-13:00 Session 3¢ Biomass estimation

13:00 — 14:00 Lunch Break

14:00 — 16:00 Session 4 Monitoring mangrove loss and gain

16:00 —16:10 Tea/Coffee Break



Introduction to Mangroves

* Most productive ecosystems in the World.

* Thrive in the tropical and sub-tropical regions along the coastal regions within
the intertidal zone.

« Cover a small land area (<1%) and responsible for 10% of global carbon export
to Oceans.

* Provide a number of both direct and indirect services to local populations.

« Can grow up to about 60m in height and to attain high values of Above Ground
Biomass (AGB) -

* Occupy the riparian zone.

« Straddle both terrestrial and marine
environments enabling them to support a very
broad range of biodiversity.
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Mangroves provides critical ecosystem services to society

* Coastal protection against tsunamis, hurricanes, storm surges, sea level rise and erosion
* Nurseries for fish, crustaceans and amphibians maintaining fish stocks and biodiversity

* Provide lumber and coal to local communities

/

* Store an extraordinary amount of carbon from the atmosphere and store in soils Pl A A SN
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reducing global warming rates. (up to 1000t/ha including soil C) 32

* Note that Carbon is used a mitigation to reduce destruction of mangrove for other unsustainable uses.

« The estimated economical value varies between $200k to $900k per km? per
year (UNEP report 2006);

* Note: These numbers need to be updated with our improved knowledge and also information on
forest structure which drives their economical value.

Mangroves are endangered

o Already 35% of mangrove forests have disappeared and 60% could be lost by 2030;
o Endangered by climate change: sea level rise

o Mostly threatened by human activity (e.g. Urbanization, over exploitation for lumber, fresh water
diversion due to construction of roads, levees and canals, pollution)

Mangrove are very important to society, however they are endangered. Most World population lives near the coasts.



Global Distribution of Mangrove Forests




Distribution of Blue Carbon

Global Distribution of Blue Carbon Ecosystems
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§& Mangroves £ Salt Marsh Seagrass

Mangroves occupy137600-152308km”2 globally (Spalding et al, 2010; Giri et al., 2011)




Height and Biomass Map of All
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Fatoyinbo & Simard, IJRSE 2012

Courtesy: Marc.simard@jpl.nasa.gov
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Country

Angola

Benin
Cameroon
Congo

Cote d'lvoire
Djibouti

DRC

Egypt
Equatorial Guinee
Eritrea
Gabon
Gambia
Ghana
Guinea
Guinea Bissao
Kenya
Liberia
Madagascar
Mauritania
Mozambique
Nigeria
Senegal
Sierra Leone
Somalia
Soudan
South Africa
Togo
Tanzania
Africa

Forests of Africa

Area in km?

154
18
1,483
15

32

17
183

181
49
1,457
519.11
76
1,389
2,806
192
189
2,059
0.4
3,054
8,573
1,200
955

30

12

809
25,960

Total Biomass in
Mg

1,441,200
137,719

25,334,900
267,603
406,516
1,653,170
51,570
8,344
2,922,420
640,038
23,840,000
5,509,300
742,925
18,153,800
31,712,300
2,294,820
2,141,860
24,856,900
4,156
30,974,100
94,788,000
11,462,100
10,655,600
436,907
135,626
40,018
15,861
11,037,800

301,665,553

Mean Biomass in Mg/ha

93
76

171
178
124

90
140
117
161
129
162
106

97
108
113
119
113
121

95
101
111

95
112
143
113
100

78
136
116



Countries (10) with most biomass (tons) - World

Country MaX(:c)aght heli\gf\:?m) "("h;’; /Ir\n(:)B M(WSI:SB Total AGB (Mg) Total C (Mg “:fgg;ﬁ:;
Indonesia 475 247 456.4 218.5 578,630,876 1138,076,289 2,647,499
Papua New Guinea 458 28.6 4325 2481 114,089,528 206,806,176 459,856
Australia 28.8 12.2 2418 121.7 111,643,417 333910624 914796
Brazil 40.7 203 260.5 94.6 97367688 354985555 1023164
Malaysia 35.6 204 308.3 176.5 92,120,954 209,655,257 522,088
Bangladesh 25.5 155 421.2 173.0 713916017 170612893 427357
Nigeria 33.9 139 355.3 99.6 68,016,334 238,906,942 682,688
Venezuela 52.6 31.7 392.8 190.1 45442016  98,147684 238,908

Cameroon 49.2 23.1 027.3 215.1 42,491,621 34,449,634 197511




Mangrove continuum is threatened by sea level rise

Anthropogenic Marshes-Mangroves Ocean



Mangroves and ecosystem services

Environmental drivers of mangrove structure: precipitation, temperature, availability of nutrients

and salinity - c/imate change

Mangroves structure divided into 4 eco-types - landscape characteristics: riverine, basin, fringe

and scrub.

Remote sensing can measure the ecosystem response in term of canopy height, above ground
biomass (AGB), species distribution and spatial patterns.
The largest driver of this loss has been the conversion of mangrove forest to aquaculture,

mariculture
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with that of major
forest domains (from
Donato et al. 2011).



SRTM (Shuttle Radar Topography Mission)

11-day mission, February 2000
Mapped DSM 80% of land surface
Spatial Sampling (30m)

Intrinsic resolution ~60m

New version soon NASADEM




ICESAT/GLAS (Geoscience Laser Altimeter System)
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Mapping Mangrove Canopy Structure
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Example: Mangroves of Guayaquil, Ecuador

Mangrove height (m)
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Forest Canopy Height derived from UAVSAR (polinSAR)

@t
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Uninhabited Aerial Vehicle Synthetic Aperture Radar — UAVSAR htips://uavsar.jpl.nasa.gov/

Canopy Height (m)
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Jet Propulsion Laboratory, 2016



https://uavsar.jpl.nasa.gov/

Mapping Change in Mangrove Extent and Identify Proximate

Drivers of Changes and Geographical Hotspots.

Distribution and Drivers of Global Mangrove Forest Change, 1996-2010 (Thomas et
al., 2017, PLOS ONE)

https://journals.plos.org/plosone/article?id=10.1371/journal.pone.0179302
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https://journals.plos.org/plosone/article?id=10.1371/journal.pone.0179302

Mapping Change in Mangrove Extent and Identify Proximate Drivers of

Changes and Geographical Hotspots.
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Distribution of different drivers of change in mangrove
forest extent

A) Advance and regrowth of mangrove extent (1996-
2010)

B) Degradation from anthropogenic drivers of change
including evidence of prior disturbance

C) Hotspots where substantial changes in mangrove
forest extent were observed (1996-2010)

D) Tiles that contained intact mangrove (1996-2010).

The total distribution of mangrove tiles is provided in
gray.




Management of entire watershed is important to the health , SER

of mangrove forests.

e
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West Papua == i 3 B8 > O Environmental drivers of mangrove structure:
Mangrove areas ‘ AR A (17 « precipitation
and height ’
* temperature,
e availability of nutrients and
e salinity.

DWatersheds

Mangrove height (m)
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Forest Height (m) and Above Ground Biomass - Kuala Sepetang

Canopy Max Height (m)

Il o
- o Kuala Sepetang
8

[ 12 E gg Town in Malaysia
% ;g 120
o4 3 160 Kuala Sepetang is a coastal town loc:
[ ]28 % =00 District, Perak, Malaysia.
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— E ggg [ Environmental drivers of

400 mangrove structure:
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* precipitation
* temperature
e availability of nutrients

. linity.
In 2000, there were about 30Mt of above ground biomass in Sepatang. salinity



NASA and Mangroves

* Mangroves are coastal ecosystems that provide important services to coastal populations. They offer
natural protection against storm surges, hurricanes and tsunamis. Mangroves also contribute to fish

stocks by providing nursing grounds for fish and crustaceans.
https://www.youtube.com/watch?v=RjSTKItUUXO0



https://www.youtube.com/watch?v=RjSTKItUUX0

NASA Earth Observing Satellites

Landsat 8 (UsGS)

-

ljik

Landsat 7 (USGS)
1999

SMAP
RapidSCAT (1ss)

CATS (IsS)

Suomi NPP

OSTM/Jason-2
2008

CALIPSO
2006 CloudSat
2006

CRNGRIQ) QuikSCAT

2004 EO- . 1999
2000 RN

e

NASA’s Earth Observing System
is a coordinated series of polar-
orbiting satellites that monitor
the land surface, biosphere,
solid Earth, atmosphere, and
oceans for long-term global
observations.

We will focus on the satellites
that provide information on
the Earth’s biosphere.




Upcoming NASA Missions

Global Ecosystem Dynamics

Investigation LIDAR (GEDI)
https://gedi.umd.edu

GEDI

Characterizing the Effects of
Climate Change and Land Use

2021

Surface Water and 7
Ocean Topography #

//:q // -
NASA-ISRO SAR Mission (NISAR)
. R e — & 4
A ’L atel -Sfé'nd |erian=lﬁ§AR mission, in partnership with ISRO, optimized for studying
1azary a['e'hvironmentgl change. e

2021



https://gedi.umd.edu/

NASA Missions - Global Ecosystem Dynamics Investigation LIDAR

(GEDI)

Enhanced Height/Biomass Using Fusion With Landsat  httos://gedi.umd.edu/ ATBD # Data products Product leads Resolution

e — : R =]
¢ =i e - - 1A: Raw waveforms, 2A:

Ground elevation, canopy Michelle Hofton ~ .
Lt top height, relative height Bryan Blair 2300 {52 ) damstor
(RH) metrics
s Scott Luthcke
eight (m) Tim Rebold .
0 5 10 15 20 25+ L1B Geolocated waveforms Taylor Thomas 25 m (~82 ft) diameter

Teresa Pennington
+20

Canopy Cover Fraction

15 L2B (CCF), CCF profile, Leaf TjﬁnT:r’;fston 25 m (~82 ft) diameter
Area Index (LAl), LAl profile
+10 Scott Luthcke
L3 Gridded Level 2 metrics Terence Sabaka 25 m (~82 ft) diameter
+5 Sandra Preaux
Jim Kellner

L4A Footprint level above ground

o
apne’

Laura Duncanson 25 m (~82 ft) diameter

DRSS John Armston
-5 i
Gridded Above Ground Sean Healey . -
= : 0 L4B Biomass Density (AGBD) Paul Patterson 1km (~0.6 mi) grid
>25 R A : Demonstrative  Prognostic ecosystem George Hurtt Grid size- Variable
products model outputs
-15
Tree height (m) Demonstrative  Enhanced height/biomass Lola Fatoyinbo Grid size: Variable
-20 products using fusion with TanDEM-X Seung-Kuk Lee ’
-22

Enhanced height/biomass

Demonstrative : . Matt Hansen .
roducts and biomass change using Chenquan Huang Grid size: Variable
p fusion with Landsat
i - . . Scott Goetz
Demonstrative  Biodiversity/habitat model Patrick Jantz Grid size: Variable

products outputs Pat Bums



https://gedi.umd.edu/

Radar Remote Sensing

Wavelength (m) Frequency(Hz)
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Radar Remote Sensing

Radar frequencies and wavelength range used for remote sensing of land surfaces

Radar Band_|Wavelengths

_ 0.60cmto 1.2m  250-500 MHz

15-30 cm 1-2 GHz

8-15 cm 2-4 GHz

4-8 cm 4-8 GHz

2.5-4 8-12 GHz
1.7-2.5cmand  12-18 GHz and

0.75-1.2 cm 27-40 GHz

Biomass
Biomass, soil moisture and ground

deformation

Agriculture monitoring

Ice, ocean, maritime navigation
lce and snow

lce and snow, sea surface winds



Synthetic Aperture Radar (SAR) - Polarization

radar antenna

Polarization transmits vertically /
polarized energy ey

Irrespective of wavelength, radar signals can transmit V)/ T &, &

horizontal (H) or vertical (V) electric- field vectors, and |

receive either horizontal (H) or vertical (V) return signals, or (

both. The basic physical processes responsible for the like- e
polarised (HH or VV) return are quasi-specular surface vertical filter
reflection. For instance, calm water (i.e. without waves) e
appears black. The cross- polarised (HV or VH) return is
usually weaker, and often associated with different

reflections due to, for instance, surface roughness. radar antenna

transmits horizontally

' l I I polarized energy
v - J
toward the Earth horizontal
\('Ir(/

backscattered vertically
polarized energy from Earth
is received by the antenna

' > >

v

—
——

horizontal
horizontal filter

recenve )

HH - for horizontal transmit and horizontal receive, d. /Z/ﬂa/ o B R e
VV - for vertical transmit and vertical receive, , T

. . . . MICKSCAtIered dorizontany
HV - for horizontal transmit and vertical receive, polarized energy from Earth

15 received by the antenna

VH - for vertical transmit and horizontal receive.



Synthetic Aperture Radar (SAR) - Polarization

Radar

Intensity

g

4 Short

Wave
Scattering I II
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Wave

©W. Walker, 2012




Radar Wavelength Interaction with Vegetation

P-band (30-100 cm) L-band _(23 cm) C-band(5cm) X-band (3 cm)

4
/

£ J’ {2
Woods Hole Research Center(;a(ili-f;i ok
: ' e o '(. ol F




Radar Wavelength Interaction with Vegetation

Figure: Color composite images of mangrove forests of the
Guayas Estuary in Ecuador:

a) ALOS-PALSAR-1 HH, HV and VV in RGB respectively, and
b) Sentinel-1 VV, VH, VV in RGB respectively.

Volume scattering dominate at all polarization and at both L-
and C-band.

Lower backscatter is observed for younger low density forest
(<100t/ha) found along the coast at the bottom of the images.

c) A color composite (HH, HV, VV) of a 6m resolution L-band
airborne (from UAVSAR) image show the distinct signature of
mangrove forest whether tall (East) or short shrub forest
(West).

Green indicates the dominance over HV in inland forest is

more significant than in mangrove forest where all polarization
configurations (HH, HV and VV)




Tea Break,.



Sources of Radar Remote Sensing Data

| The Timeline of Past, Current, and Future SAR Sensors \

&

= 4?78 BB 012011 022012

The Legacy: lf

The Now:
Té‘}M-X
o 2018
The Future: i\" /;
SAOCOM PAZ SAR

Strait of Singapore — TerraSAR-X StripMap — © Astrium Services / Infoterra GmbH



Sources of Radar Remote Sensing Data SERV "' |

Platform/Instrument Where to get the data

JERS-1 L-band http://www.eorc.jaxa.jp/ALOS/en/palsar fnf/fnf index.htm
ALOS-1/PALSAR L-band http://www.eorc.jaxa.jp/ALOS/en/palsar fnf/fnf index.htm

L-band http://www.eorc.jaxa.jp/ALOS/en/palsar_fnf/fnf_index.htm
m C-band https://scihub.copernicus.eu/dhus/#/home

Sentinel-1B C-band https://scihub.copernicus.eu/dhus/#/home

NASA’s SRTM C-band DEM and https://earthexplorer.usgs.gov/ or

NASADEM in 2019 https://search.earthdata.nasa.gov/search?q=SRTMGL1%20V003
X-band DEM https://centaurus.caf.dlr.de:8443/eoweb-
ng/template/default/welcome/entryPage.vm
TanDEM-X X-band DEM ( https://centaurus.caf.dlr.de:8443/eoweb-

from TerraSAR-  ng/template/default/welcome/entryPage.vm (as of June 2018, not yet

X) freely available)


http://www.eorc.jaxa.jp/ALOS/en/palsar_fnf/fnf_index.htm
http://www.eorc.jaxa.jp/ALOS/en/palsar_fnf/fnf_index.htm
http://www.eorc.jaxa.jp/ALOS/en/palsar_fnf/fnf_index.htm
https://scihub.copernicus.eu/dhus/
https://scihub.copernicus.eu/dhus/
https://earthexplorer.usgs.gov/
https://search.earthdata.nasa.gov/search?q=SRTMGL1%20V003
https://centaurus.caf.dlr.de:8443/eoweb-ng/template/default/welcome/entryPage.vm
https://centaurus.caf.dlr.de:8443/eoweb-ng/template/default/welcome/entryPage.vm

Exercise — SNAP, QGIS

e Install SNAP
e Install QGIS

* Explore data sources:
JALOS Mosaics - http://www.eorc.jaxa.jp/ALOS/en/palsar fnf/fnf index.htm
JALOS - https://vertex.daac.asf.alaska.edu/
Sentinel 1 - https://scihub.copernicus.eu/dhus/#/home



http://www.eorc.jaxa.jp/ALOS/en/palsar_fnf/fnf_index.htm
https://vertex.daac.asf.alaska.edu/
https://scihub.copernicus.eu/dhus/

step.esa.int/main/download/

SNAP step \\ \\\\\\
science toolbox exploitation platform K

ESA STEP TOOLBOXES uWUlReL\E GALLERY DOCUMENTATION COMMUNITY THIRD PARTY PLUGINS

eSd

SNAP bundles all ESA

tools for the processing

of Sentinel data (both SNap

SAR and optical) B
Sentinel-3 Toolbox rome > Download S ;a m

SMOS Toolbox

Search

Free and Open source Proba-V Toolbox Download

Download

Community Here you can download the latest installers for SNAP and the Sentinel Toolboxes. 2018
Download SNAP Useful Links

Data provision is available to all users via the Sentinel Data Hub.

Current Version

SNAP=Sentinel Application Platform
http://step.esa.int/main/download/

The current version is 6.0.0 (15.01.2018 15:25 UTC).

Mapping Urban Areas from Space

. For detailed information about changes made for this release please have a look at the " o
Read |nf0' ) . . (MUAS 2018)
. release notes of the different projects: SNAP, S1TBX, S2TBX, S3TBX, SMOS Box, PROBA-V
. . Toolbox 2
http://step.esa.int/main/toolboxes/s : 4’:' v,
1 1 ffer tt different installers for your convenience. Choose the one from the followin YE ES“RTBWOWWEEK
. . We offer three differ : - - . : pen Science urel

nap/, STEP: http://step.esa.int/main/ _ for your _ : b

table which suits your needs. During the installation process, each toolbox can be excluded \

6 Naverder 2018 | ESA-ESRIN | Frascati (Reme), Ttaly

from the installation. Toolboxes which are not initially installed via the installer can be later
downloaded and installed using the plugin manager. Please note that SNAP and the
individual Sentinel Toolboxes also support numerous sensors other than Sentinel.

EQ Open Science zo18



http://step.esa.int/main/download/
http://step.esa.int/main/toolboxes/snap/
http://step.esa.int/main/
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® www.eorc.jaxa.jp/ALOS/en/palsar_fnf/fnf_index.htm

ftest Headlines @ BrowserRAS & OLSON'S MAJORW.. 3 Cyberpresse | ELEC...

Download Data

Click here:

* http://www.eorc.jaxa.jp/ALOS/en/palsar fnf/fnf index.htm
Scroll down to #4 “Download” and register:

e http://www.eorc.jaxa.jp/ALOS/en/palsar fnf/registration.htm

Follow instruction including confirming your email.
Once registered:
1. Click on Dataset on the left hand side:
* http://www.eorc.jaxa.jp/ALOS/en/dataset/dataset inde
x.htm
* Click on “Global PALSAR-2/PALSAR/JERS-1 Mosaic and
Forest/Non-Forest map”
e Scroll down to “4.Download” and click on

“http://www.eorc.jaxa.jp/ALOS/en/palsar fnf/data/inde

x.htm”
* Enter username (email) and password (sent by email).

SERVIRE:

Image Library

ALOS-2 Project

Calibration&Validation

ALOS
Observation Strategy

Use DATA

Conference
& Workshop

Kyoto & Carbon
Initiative

Research
Announcement

B e @ ¥  Q jaxa mosaics

E AmericasMangrove... [] Quebec_env

= 7T
R

NSty Home| Site Map| Contact Us| Japanese ”M:'}

Home > Dataset > Global PALSAR-2/PALSAR/JERS-1 Moszic and Forest/Non-Forest map

Global PALSAR-2/PALSAR/JERS-1 Mosaic and
Forest/Non-Forest map

Oct. 2, 2017: Dataset description document has been updated (Ver. E).

Jun. 20, 2017: [NEW!]Replaced 9 tiles of 2015 dataset. The replaced tiles are as follows:

N16E145,N16E146,N17E145,N17E146,N18E145,N18E146,N19E145,N19E146,N20E 145
May. 24, 2017:
Apr. 27, 2017:

About data utilization has been added.

PALSAR-2 global mosaic and forest/non-forest map in 2016 are released. Reprocessed
version of PALSAR-2 global mosaic and forest/non-forest map in 2015 are released.
Dataset description document has been updated (Ver.D).

* The data around Japan will be available in the near future.

Jan. 11, 2017: JERS-1 SAR yearly mosaic for tropical regions from 1993 to 1998 are released. Dataset

description document has been updated (Ver. C).

Oct. 31, 2016: JERS-1 SAR global mosaic in 1996 are released. Dataset description document has been

updated (Ver. B).

May. 10, 2016: Dataset description document has been updated (Ver. A).

Apr. 6, 2016: (Correction) of a figure 1 used in [Global 25m Resolution PALSAR-2/PALSAR Mosaic and
Forest/Non-Forest Map]

Mar. 28, 2016: PALSAR-2 global mosaic and forest/non-forest map for Japan in 2015 are released.

Mar. 28, 2016: Low resolution forest/non-forest maps (0.25 degrees and 1km) are released.

Jan. 25, 2016: PALSAR-2 global mosaic and forest/non-forest map in 2015.

* Data for Japan (using polarimetry mode) will be available soon.

PALSAR global mosaic and forest/non-forest map in 2007, 2008, 2009 and 2010.

Global 25m resolutions PALSAR-2/PALSAR mosaic and forest/non-forest map are free and open
dataset generated by applying JAXA's powerful processing and sophisticated analysis
method/techniques to a lot of images obtained with Japanese L-band Synthetic Aperture Radars
(PALSAR and PALSAR-2) on Advanced Land Observing Satellite (ALOS) and Advanced Land Observing
Satellite-2 (ALOS-2).

Jan. 16, 2014:

For understanding and responding to global environmental changes such as global warming and loss
of biodiversity, timely assessment of deforestation and forest degradation is essential. Global
monitoring with satellite remote sensing is one of the most effective approaches to detect land
surface changes because satellites can provide wall-to-wall images covering wide areas periodically.
L-band Synthetic Aperture Radars (SAR) on ALOS and ALOS-2 can observe the land surface even
under clouds, and therefore the L-band SAR data have been providing useful information about forest
changes in tropical region.

The global 25m resolutions PALSAR/PALSAR-2 mosaic is a seamless global SAR image created by


http://www.eorc.jaxa.jp/ALOS/en/palsar_fnf/fnf_index.htm
http://www.eorc.jaxa.jp/ALOS/en/palsar_fnf/registration.htm
http://www.eorc.jaxa.jp/ALOS/en/dataset/dataset_index.htm
http://www.eorc.jaxa.jp/ALOS/en/palsar_fnf/fnf_index.htm
http://www.eorc.jaxa.jp/ALOS/en/palsar_fnf/data/index.htm

Jaxa Mosaics

JERS-1 is a L-band HH-only instrument. Global mosaic
only available for 1996

For PALSAR, JAXA plans on generating yearly mosaics.

* PALSAR mosaics are available for 2007, 2008, 2009
and 2010

PALSAR-2 mosaics are available for 2015, 2016,
2017 and soon 2018.

* Click on PALSAR 2007 for example.

SERVIR:S

<)> C o @® www.eorc.jaxa.jp/ALOS/en/palsar_fnf/data/index.htm
Most Visited Getting Started Latest Headlines BrowserRAS & OLSON'S MAJOR W... Cyberpresse | ELEC... AmericasMangrove. Quebec_env
g 3 5 p - 3 € 3

v Your Firefox is critically out of date. An update is required to stay secure.

Update Now |

Global PALSAR-2/PALSAR/JERS-11p "

R
:Mosalc and'Forest/ Non-Forest map* T QZ%

ALOS Home > about PALSAR-2/PALSAR Global Forest / Non-forest Map > Global PALSAR-2/PALSAR/JERS-1 Mosaic and Forest / Non-forest Map

Global PALSAR-2/PALSAR/JERS-1 Mosaic and Forest / Non-forest Map

« These map uses Javascript. Please enable JavaScript on your browser.

25m resolution product

Global

* JERS-1 SAR Mosaic:

>> 1996

e PALSAR/PALSAR-2 mosaic and forest/non-forest (FNF) map:

>> 2007 >> 2008 >> 2009 >> 2010 >> 2015
>> 2016 >> 2017

Tropical region (Amazon, Africa, and SE-Asia)

* JERS-1 SAR Mosaic:

>> 1993 >> 1994 >> 1995 >> 1996 >> 1997
>> 1998

Low resolution product

PALSAR-2/PALSAR

* 100m resolution product (mosaic and FNF map):

>> 2007 >> 2008 >> 2009 >> 2010




<)=> C ® www.eorc.jaxa.jp/ALOS/en/palsar_fnf/data/2007/map.htm
L¥ Most Visited w Getting Started 33\ Latest Headlines @ BrowserRAS & OLSON'S MAJORW.. 3\ Cyberpresse | ELEC... m AmericasMangrove... 5] Quebec_env

v Your Firefox is critically out of date. An update is required to stay secure. (_Update Now

Example: . e

ALOS/PALSAR-1 Mosaic 2007 #Global PALSAR2/PALSAR/JERS

Vo KAy .

.

siMosaic and‘ Fo'EestY Non-‘Forest map

a3 SR el b

PALSAR Global Forest / Non-forest Map "2007"

>> 2017 >> 2016 >> 2015 >> 2010 >> 2009 >> 2008

e Click on your favorite region.

 Example in this workshop: Kenya’s coast ~ Feeseciextearavnicn dounioads amosaic

e Click until you end-up at the desired
location.

* Note all mosaic grid-cells are 1°x1°.

-

SERVIR:

Earth Observation Research Center ;
Copyright©1997- JAXA EORC Al rights reserved.
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(
S E RVI R s'q ‘ e ’ALOS AL Download J P/A'-OS/ n/palsa Download_JERS-1 Mosaic kenya utm zone - Google Search
\ [*07 7
5)% V.

Global PALSAR-Z/ PALSAR/JERS-1 .

'Mosa:c and yForest/ Non- Forest map-
Download 1 degree cell. Bt htre et

* For PALSAR-1 and PALSAR-2, there are 3 mosaics: sk

« FNF=Forest vs Non-Forest map (M. Shimada, T. Itoh, =
T. Motooka, M. Watanabe, T. Shiraishi, R. Thapa, and
R. Lucas, “New global forest/non-forest maps from
ALOS PALSAR data (2007-2010),” Remote Sens.
Environ., vol. 155, pp. 13-31, 2014.)

 HH. Mosaic of Horizontal-transmit and Horizontal-
receive polarization. Sensitive to both volume and
surface. Excellent for monitoring wetlands, forest-
inundations, urban infrastructure and expansion.

* HV. Mosaic of Horizontal-transmit and Vertical-
receive polarization. Sensitive to volumes such as mor |
vegetation density. Excellent to distinguish and
monitor forests.

* Download file by cliking on “DownLoad”. The file will
automatically download to computer (zipped file for HH
and HV is about 65MB)

e Unzip files. They are in ENVI format that can be opened

in ENVI or QGIS. You can also use gdal_translate to "
convert in any format.

Download

FNF




Download raw ALOS/PALSAR-1 data

* Go to the Aalska Satellite Facility Vertex
interface: https://vertex.daac.asf.alaska.edu/

e Click on “Geographic Search”
* Follow interactive instructions steps.

* Then click on top right “Earthdata Login” to
register (free)
* Follow instructions and email receipt

* Go back to:

* https://vertex.daac.asf.alaska.edu/
* Login.

* Use mouse cursor to top left corner of your
favorite site, click and take cursor to the
bottom right corner of your site, and click
again. A box will be drawn on your site. These
coordinates will be written automatically in the
“Geographic Region” tab.

* Enter range of dates for which you seek data.

* For PALSAR-1, it should include dates between 2007
and 2010.
* The “Path” and “Frame” are optional.

e Click “Search” at the bottom.

SERVIR# )

A
£¥ Most Visited (@) Getting Started ) Latest Headlines @ BrowserRAS & OLSON'S MAJORW.. R\ Cyberpresse | ELEC.. [ AmericasMangrove... Quebec_env

WALASKA SATELLITE FACILITY

ertex Is the Alaska Satellite Facility’s data po

Vertex Interactive Tours ~ Help ~ ASF Home 2 Logout Marc Download Queue u Contact

G tial  Granul Mi pietciMag) Souttinok Please use the map and/or the search parameters on the
- Sl left to select your search criteria.
v Geographic Region e

Option 1: Click on map and move cursor
Option 2: Enter coordinates:

e.g., -102,37.59,-94,37,-94,39,-102,39,-102,37.59
Counterclockwise, decimal degrees, (long,lat)

v Date (]

(O Seasonal | Search

@ EARTHDATA LOGIN

Start Date (yyyy-mm-dd)

End l?ate (yyyy-mm-dd) — A LAS KA
2018-08-20 & SATELLITE
o - 'h M. FACILITY

Select: All | None

Dataset Info
@ Sentinel-1B 2016-now @
Sentinel-1A 2014-now ©
) SMAP 2015-now @
(0 UAVSAR 2008-now &
(D ALOS PALSAR 2006-2011 @
(0 RADARSAT-1 1995-2008 ©
O ERS-2 1995-2011 @
(O JERS-1 1992-1998 ©
O ERS-1 1991-1997 @
(O AIRSAR 1990-2004 ©
(J SEASAT 1978-1978 @
v Path & Frame (optional) o
Sta A E A \
Path Start 6] End 6]
Frame Start 6] End 6] p
ofe| (3 R
O Omit Geographic Region from search - - -
Number of Frames
1 [liEssssosi— T

—


https://vertex.daac.asf.alaska.edu/
https://vertex.daac.asf.alaska.edu/

)
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q
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\

n
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Select data

A list of files will appear on the right with browse
images (i.e. low-resolution thumbnail)
Files with different imaging modes will be available.

1. “WB1” is (ScanSAR) Wide-Beam #1,

2. PLR s fully polarimetric dataset with HH, HV and
vV
FBD is Fine-Beam Dual polarization including HH
and HV.

4. FBSis Fine-Beam Single polarization (HH).
In our example, high resolution ascending-orbit images
are available, along with WB1 descending-orbit images.
Ascending and descending mean the targets are seen
from the West and East respectively.

I N N O

Swath 240km 70km 70km 30km
Resolution 100m 20m 10m 30m
Incidence 18-43° 34.3° 34.3° 21.5°
angle (27.1)

Hint: Long 39.182111, lat -5.0220668
Path: 233, Frame: 3750

[+ Bl

kenya utm zone - Google Search

000 (£
Vertex: ASF's Data Portal

s EARTHDATA

UAF ALAskA SATELLITE FaciLiTy

Vertex is the Alaska Satellite Facility's data portal for remotely sensed imagery of the Earth

i vertex.daac.asf.alaska.edu (@) =)

i

Download www.eorc.jaxa.jp/ALOS/en/palsar._... Download_JERS-1 Mosaic

Science Disciplines

Community

Data Discovery

Vertex Interactive Tours ~ Help ~ ASF Home 7 2 Earthdata Login Download Queue n Contact
- Find
World Map | South Polar
Geospatial Granuls @ Satellite Showing 1 to 17 of 17 entries
Missions O Map ALOS PALSAR 2009-04-
WB1 20
ALPSRS172453750

¥ Geographic Region (i ]

Option 1: Click on map and move
cursor

Frame 3750, Path 233
Off-Nadir 27.1°
Matching Frames 0

Data source
Option 2: Enter coordinates: JAXA/METI
© Details v Queue
|39.04.-536.3948.—5.36.39.8.-3.89,39.04.
e.g., -102,37.59,-94,37,-94,39,-102,3 ALOS PALSAR 2009-04-
9,-102,37.59 wWB1 20
ALPSRS172453700

Counterclockwise, decimal degrees,

(long, lat) Frame 3700, Path 233

Off-Nadir 27.1°
Matching Frames 0
Data source
JAXA/METI

© Details ¥ Queue

¥ Date

I

[0 Seasonal Search

Start Date (yyyy-mm-dd)

1978-01-01 ] ALOS PALSAR 2009-04-
WB1 15
End Date (yyyy-mm-dd) ALPSRS171723750
_ Frame 3750, Path 230 m
2018-04-12 ] Off-Nadir 27.1°
Matching Frames 0
Data source
AT
® Details v Queue
Select: All | None
ALOS PALSAR 2009-04-
Dataset Info WB1 15
(0 Sentinel-1B 2016-now @ ALPSRS171723700
([ Sentinel-1A 2014-now @ ;r:fxr:‘: 3207 1Poath 230
- il .
LISMAD 2015-n0% @ Matching Frames 0
OUAVSAR 2008-nov: @ Data source
ALOS PALSAR 2006-2011 @ JAXA/METI
(0 RADARSAT-1 1995-2008 @ @ Details v Queue
[ ERS-2 1995-2011 @
(JJERS-1 1992-1998 @ ALOS PALSAR 2008-01-
(J ERS-1 1991-1997 @ | T 55
[(JAIRSAR 1990-2004 @ paer | pes
[ SEASAT 1978-1978 @
+ Path & Frame (optional) e Number of Frames
[ 1
Path  Start [0 End ()

Copyright © 2018 Alaska Satelite Facility
Vertex: ASF's Data Portal V2.48.00-38
Phone: (907) 474-5041 ¥ Contact

UA s an AA/EO employer and educational institution and prohibits illegal discrimination against any
individual:
www.alaska.edu/nondiscrimination.

Vertex

4L




Select data

AN

SERVIRE:)

 Click on “Details” if you want information
on available images

e Click on “Queue” to add them to the

gueue for download:

* A drop down menu will appear with
a choice of Level 1.0, 1.1, 1.5, or
radiometrically terrain-corrected
(RTC). This choice depends on mode.

Try it out.

I U N E N

Geographic
projection
Radiometric
format

Radar
(SLC)

Single

look
pixel

Radar (SLC)

Equally
spaced single
look pixel in
radar
coordinates

Geographic

Multilook and calibrated but
with topographic features. Data

geograp
hic

Science-
ready

equally spaced on ground.

000 (£ i
Vertex: ASF's Data Portal

“ EARTHDATA Data Discovery

Download

Community

UAF ALAskA SATELLITE FaciLiTy

Vertex is the Alaska Satellite Facility's data portal for remotely sensed imagery of the Earth

Vertex Interactive Tours ~
Geospatial Granule
Missions

¥ Geographic Region (i ]

Option 1: Click on map and move
cursor

Option 2: Enter coordinates:

|39.04.-536,3948.—5.36.39.8.—3.89,39.04.
e.g., -102,37.59,-94,37,-94,39,-102,3
9,-102,37.59

Counterclockwise, decimal degrees,
(long, lat)

[0 Seasonal Search

Start Date (yyyy-mm-dd)

1978-01-01 i&@
End Date (yyyy-mm-dd)
2018-04-12 i@

Vv Dataset

I

Select: All | None

Dataset Info

(0 Sentinel-1B 2016-now @
([ Sentinel-1A 2014-now @
O SMAP 2015-now @
[JUAVSAR 2008-now @
ALOS PALSAR 2006-2011 @
[0 RADARSAT-1 1995-2008 @
D ERS-2 1995-2011 @
(O JERS-1 1992-1998 @
(D ERS-1 1991-1997 @
(D AIRSAR 1990-2004 @
(O SEASAT 1978-1978 @
Path | Start [I] End [

Copyright © 2018 Alaska Satelite Facility
Vertex: ASF's Data Portal V2.48.00-38
Phone: (907) 474-5041 ¥ Contact

Help ~

ASF Home 7

@ vertex.daac.asf.alaska.edu

www.eorc.jaxa.jp/ALOS/en/palsar._...

Science Disciplines

Number of Frames

|1 e
Vertex

()

Download_JERS-1 Mosaic

2 Earthdata Login

oj(d][@

kenya utm zone - Google Search

Download Queue [[J

Find

Contact

Showing 1 to 17 of 17 entries

-l-L

Add to Queue by Type «

UA s an AA/EO employer and educational institution and prohibits illegal discrimination against any

ALOS PALSAR
WB1
ALPSRS172453750
Frame 3750, Path 233
Off-Nadir 27.1°
Matching Frames 0
Data source
JAXA/METI

© Details v Queue

ALOS PALSAR
WB1
ALPSRS172453700
Frame 3700, Path 233
Off-Nadir 27.1°
Matching Frames 0
Data source
JAXA/METI

© Details ¥ Queue

ALOS PALSAR
WB1
ALPSRS171723750
Frame 3750, Path 230
Off-Nadir 27.1°
Matching Frames 0
Data source
JAXA/METI

® Details v Queue

ALOS PALSAR
WB1
ALPSRS171723700
Frame 3700, Path 230
Off-Nadir 27.1°
Matching Frames 0
Data source
JAXA/METI

© Details ¥ Queue

ALOS PALSAR

2009-04-
20

2009-04-
20

2009-04-

2009-04-

2008-01-
04

Previous Next

individual:

www.alaska.edu/nondiscrimination.

4L




Data coverage by processing level

* To see if a given processing level is
available at your site, click on
https://www.asf.alaska.edu/sar-

data/palsar/alos-acquisition-maps/

ALOS L1.5 FBS
Coverage Map

)

7%
\k

q
\
\

IS
v/

SERVIR#:

ALOS L1.5FBD
Coverage Map

ALOS L1.5 Polarimetric
Coverage Map

000 £ il

¥eqpasy

SAR Datasets [ ALOS PALSAR [ AL...

& asf.alaska.edu

Download www.eorc.jaxa.jp/ALOS/en/palsar_...

UAF ALASKA SATELLITE FACILITY

Making remote-sensing data accessible since 1991

# Home Get Started

Get Data Datasets Data Tools

# /SAR Datasets / ALOS PALSAR / ALOS Coverage Maps

ALOS PALSAR

About ALOS
PALSAR

Terrain Corrected
(RTC)
Get Data

Documents &
Tools

Maps
Terms &
Conditions
How to Cite
Sentinel-1
AIRSAR
ERS-1
ERS-2
INSAR
JERS-1
RADARSAT-1
Sea Ice MEaSUREs
Seasat
SMAP
Terrestrial Ecology
UAVSAR
Wetlands MEaSUREs

h

ALASKA
SATELLITE

FACILITY

ALOS Coverage Maps

ALOS L1.5FBS
Coverage Map

ALOS L1.5FBD
Coverage Map

Tutorials

¢ ©

Download_JERS-1 Mosaic

About ASF

o NN
R
| . N 3

B Q@ uu
ALOS L1.5 Wide ALOS L1.5
Beam Coverage Polarimetric
Map Coverage Map

ALOSL1.1
Coverage Map

ALOS RTC
Coverage Map

& About Us

The Alaska Satellite Facility
downlinks, processes, archives,
and distributes remote-sensing
data to scientific users around the
world. ASF's mission is to make
remote-sensing data accessible.

& Contact Info

Alaska Satellite Facility
9 2156 Koyukuk Drive
Fairbanks, AK 99775

L. (907) 474-5041
& Contact Us

< Social Networks

o £

t

kenya utm zone - Google Search

al

Get SAR Data

4L



https://www.asf.alaska.edu/sar-data/palsar/alos-acquisition-maps/

®@® O (< 5l # media.asf.alaska.edu ] (4] M )

alos-rtc-map.png 3,507x2,480 pixels Download www.eorc.jaxa.jp/ALOS/en/palsar_... Download_JERS-1 Mosaic kenya utm zone - Google Search +

Example of processed RTC data (by ASF): colors indicate the number of available processed scenes

180 150 120 90 60 30 0 30 60 €0 120 150 180

90

ALOS PALSAR Global Radar Imagery, 2006-2011

ALOS PALSAR Radiometric Terrain Correction (RTC) Data Coverage
https://www.asf.alaska.edu/sar-data/palsar/alos-acquisition-maps/

7. ALASKA
SERVIRfG sty

Map shows the total of ALOS PALSAR Radiometric Terrain Correction
(RTC) product coverage in the ASF archive

ALOS-PALSAR data are open access and can be downloaded using,
ASF’s Vertex data portal [vertex.daac.asf.alaska.edul


https://www.asf.alaska.edu/sar-data/palsar/alos-acquisition-maps/

Access and Download of Sentinel-1

https://scihub.copernicus.eu/dhus/#/home

* Free access to the full Sentinel —
archive (1,2, and 3) T

« The archive can be filtered
spatially and/or based on several

* Results are displayed as entries in | s | g
the result list and as footprints on
the map



https://scihub.copernicus.eu/dhus/

Data processing

=» SNAP | Sentinels Application Platform

* Open radar images in SNAP
Radiometric calibration

Image filtering to reduce speckle
Open in QGIS

one loading module

Lesa
dB conversion eo

sclentific axploitation
llllll toral nisslens

Windows 64-Bit Windows 32-Bit Mac OS X Unix 64-bit
- These installers contain the Sentinel-1, Sentinel-2, Sentinel-3 Toolboxes
Sentinel
Toolboxes Download Download Download Download
These installer contains only the SMOS Toolbox.
Download also the Format Conversion Tool (Earth Explorer to NetCDF) and the user
SMOS Toolbox manual.
Download Download Download Download

These installers contain the Sentinel-1, Sentinel-2, Sentinel-3 Toolboxes, SMOS

d PROBA-V Toolbox
All Toolboxes an oolbox

Download Download Download Download




Using SNAP to process raw radar data

 Read

. Begin processing with Level 1.1 data. The 1.5 and RTC product data are already processed. Try to use SNAP
and process Level 1.1 to RTC!.

+ Drag and drop the VolI* file into “Product Explorer” window =~ =% &® Slile <®« : 08 25090 =

° Cal i brate v ?é] 9}%:5};:7A—0RBIT7ALPSRPO73337100

» (23 Tie-Point Grids

+ Go to "Radar” menu at top of screen. A window pops-up. " S

E qHH

* In the window, specify the input band and output file location. | @ e

* In the same window, click on the @ a0
Processing Parameters” tab:

« Select any “intensity” band.
« Select betalO band.

Navigation - [... £ | Uncertainty Visua... World View l

@,
& Calibration X @
File Help @L
- a.
1/O Parameters | Processing Parameters @
Source Product *
source:
[1] ALOS-H1_1_ A-ORBIT__ALPSRP121037060 v|[-
Target Product
Name: — =
ALOS-H1_1_ A-ORBIT__ALPSRP121037060_Cal 1:27.59 ° ‘@
[/ save as: | BEAM-DIMAP v Radar Tools Window Help
Directory: Product Explorer X | Pixel Info <
C:\SAR_Mangrove\Output -6 [1] ALOSH1_1_ A-ORBIT_ ALPSRP121037060 Apply Orbit File 9 I & Y K ,4& B
o - [2] ALOSH1_1_A-ORBIT__ALPSRP121037060_Cal Radiometric > Calibrate
(1 Metadata e Filteri
- @3 Vector Data Speckle Filtering g Radiometric Terrain Flattening
i@ Tie-Point Grids Coregistration > Remove Antenna Pattern
=-&3 Bands .
> .
) Interferometric S-1 Thermal Noise Removal
E B sigmao_Hv Polarimetric >
Geometric >



Using SNAP to process raw radar data

* Read
e Calibrate
* Apply terrain correction

* Go to: “Radar” top menu and select
“Radiometric”->"Radiometric Terrain
Flattening”

* In “Processing Parameters” tab, select
“Betal”

* Click “Run”

* Note this brings the image from Beta0 to
GammaoO. i.e. removing topographic
effects on backscatter.

Filter radar image (e.g. Lee Filter)
Project to ground range

Convert linear to decibels (dB)
Write output

ag o Ele X w0 QA ANV RO R =

—

» (1 Metadata

» [ Vector Data

» (33 Tie-Point Grids

v & Bands
B iHH
B qHH File Help
E Intensity_HH
B inv 1/O Parameters
E q_nv

Bl Intensity_Hv Source Bands: Sigma0_HV
[4] ALOS-H1_1_ A-ORBIT__ALPSRP073337100_Cal BetaO

Metadata

v

s
3 Vector Data
3 Tie-Point Grids
& Bands

[ sigma0_Hv

=
>
4
4
v

m BetaO
Navigation - [... & I Uncertainty Visua... World View |

Digital Elevation Model:  SRTM 1Sec HGT (Auto Download)

DEM Resampling Method: | g|CUBIC_INTERPOLATION

v Re-grid method

B2 2 o p L

1:27.59 0° o2

Lat

Srtm 44_14



Using SNAP to process raw radar data

* Read

« Calibrate

» Apply terrain correction (Project to ground range)

* Filter

“‘Radar’->"Geometric’->"Terrain Correction’->"Range-
Doppler Terrain Correction”. Window pops-up.

Select input filtered band and specify output.

In “Processing parameters”, select Gamma0O_HH or
Beta

Select spatial resolution of output file (default is radar
sampling)

Save useful bands: e.g. “Selected source band”,
‘DEM?”, “projected local incidence angle”

If ground projection is incorrect, use the “Radar’-
>"Geometric”>"Terraint Correction”->"SAR-Simulation
Terrain Correction”

radar image (e.g. Lee Filter)

« Convert linear to decibels (dB)

* Write

output

: = LA =0 @ BLE
: ﬁ “f P e Pe '/?@ . -:'5~( ,g-ﬂ j
: - W e % K, Help
Product Explorer £ | Pixel Info | ‘
[Z3 Tie-Point Grids 1/O Parameters
I3 Bands
B Beta0 Source Bands: Beta0
[7] ALOS-H1_1_ A-ORBIT__ALPSRP073337100_Ca
21 Metadata
23 Vector Data
(22 Tie-Point Grids
I= Bands
@ Gamma0
[8] ALOS-H1_1_ A-ORBIT__ALPSRP073337100_Ca
23 Metadata Digital Elevation Model: SRTM 3Sec (Auto Download) s
23 Vector Data )
[C3 Tie-Point Grids DEM Resampling Method: BILINEAR_INTERPOLATION 5
Band 5
aiE=ccE Image Resampling Method: BILINEAR_INTERPOLATION 5
[ Betad =
[9] ALOS-H1_1_ A-ORBIT__ALPSRP073337100_Ca Source GR Pixel Spacings (az x rg): 3.19(m) x 15.72(m)
[10] ALOS-H1_1_ A-ORBIT__ALPSRP073337100_( Pixel Spacing (m): 25
‘ ixel ing (d
Navigation - [... | Uncertainty Visua... World\‘ R SR (e 2.2457882102988038E-4
Map Projection: WGS84(DD)
v Mask out areas without elevation Output complex data
Output bands for:
v Selected source band v DEM Latitude & Longitude
Incidence angle from ellipsoid v Local incidence angle v Projected local incidence angle
Apply radiometric normalization
Save Sigma0 band Use projected local incidence angle from DEM
Save Gamma0 band Use projected local incidence angle from DEM
Save Beta0O band
Auxiliary File (ASAR only): Latest Auxiliary File
1:27.59 0° Run Close
R T Lo

Srtm 44_14



Using SNAP to process raw radar data

& Single Product Speckle Filter X Radar Tools Window Help
¢ Read File Help Apply Orbit File PwlE Y G i
Radiometric >
. s _ Speckle Filtering 2 Single Product Speckle Filter B
°® C I b t :1/O Parameters | processing Parameters S
a I ra e Coregistration > Multi-temporal Speckle Filter
Source Product Interferometric >
* Apply terrain correction
pp y [3] ALOSH1_1__A-ORBIT__ALPSRP121037060_Cal_TC ( Single Product Speckle Filter X
* Filter radar image (e.g. Lee Target roduct File Help
. Name:
Fl|tel’) ALOS-H1_1__ A-ORBIT__ALPSRP121037060_Cal_TC_Spk 1/O Parameters Processing Parameters

o Select Speckle Filtering -> Single | Hsess: smome
Product Speckle Filter e

C:\SAR_Mangrove\Output

o Select Lee Sigma (2] Openin 1P Source Bands:

locallncdenceAngle

« Convert linear to decibels (dB) projecteorainasenceina
. iter: ee Sigma v
° erte Output Run :t:mber of Looks: I; — y
Window Size: 7 v
Sigma: 0.9 v
Target Window Size: | 33 v

Close




Using SNAP to process raw radar data

Raster Optical Radar Tools Window Help E‘COH\/ertS bands to/from dB X

. Band Maths... @ \@; M‘ ‘_”. Z % E_"} File Help

Filtered Band...

8l (2 Beta0_HH % [ [2] Beta0_HV X

1O Parameters Processing Parameters

H
F Source Bands: |Sigma0_HH
P Geo-Coding Displacement Bands... Sigma0_HV
F Subset... BetaO_HH
DEM Tools > elevation
Maske 5 locallncidenceAngle

projectedLocallncidenceAngle

Data Conversion
Image Analysis

Classification

Convert Datatype
Converts bands to/from dB
Amplitude to/from Intensity

Segmentation ? Linear to/from dB

Export >

» Convert linear to decibels (dB) T T——— : .

 Top menu “Raster’->"Data Conversion™ ™ ™ .
> ’ CO n Ve rtS b a n d S tO/frO m d B ” 1/O Parameters  processing Parameters I

« Select input band and output file. 0

[4] ALOSH1_1_ A-ORBIT__ALPSRP121037060_Cal_TC_Spk v

» Write output

o 7 F | Ie”_> ” Expo rt”_>” G eotlff” fo r ALOS.-Hl_l_AORBIT_ALPSRP 121037060_Cal_TC_Spk_dB
convenience

Run Close

[] 5ave as: BEAM-DIMAP v
Directory:
C:\SAR _Mangrove\Output

Open in SNAP

Close




Using SNAP to process raw radar data

File Edit View Analysis Layer Vector Raster Optical Radar Tools Wi {8 SNAP - Export Product X
| / Save in: Output v [T~
& Open Product b . { ’ = A& [ vein utpu & ¥
Reopen Product > ALOS-H1_1_A-ORBIT_ALPSRP121037060_Cal.data | Subset...
¥ Product Libra ol ALOS-H1_1_A-ORBIT_ALPSRP121037060_Cal_TC.data
Y LPSRP 121037060 L ALOS-H1_1_A-ORBIT_ALPSRP121037060_Cal_TC_Spk.data
Close Product | I ALOS-H1_1_A-ORBIT_ALPSRP121037060_Cal_TC_Spk_dB.data
\LPSRP121037060_Ca
Close Al Products LPSRP121037060_Cal_TC Vi
Close Other Products \LPSRP121037060_Cal_TC_Spk Desktop
T PSRP121037060_Cal_TC_Spk_dB
Save Product As... Documents
Session >
Projects > Ld
Import > Mubea
Export ? Other >
A Lé File name: H1_1_ A-ORBIT__ALPSRP121037060_Cal_TC_S¢
. Exit SAR Formats > Network Fles of tyoe: | GeoTIFF product (=.tf, 1ff) P
* Write Output SMOS EE Files to NetCDF... o

- "File”->"Export’->"Geotiff’ e

fOI’ convenience SMOS Grid Points ...
JPEG-2000

csv
| Navigation - ... X | Colour Manipt GeoTIFF / BigTIFF
BEAM-DIMAP
ENVI
GeoTIFF
HDF5
NetCDF4-BEAM
NetCDF4-CF
NetCDF-BEAM
NetCDF-CF




Using SNAP to process raw radar data -

automation

URead
QCalibrate
UApply terrain correction

QFilter radar image (e.g.
Lee Filter)

UProject to ground range

dConvert linear to
decibels (dB)

Write output

~N o

. Select "Graph Builder"

Inset processing steps using
right-click

Insert and connect all processing
graphs

Processing step parameters can
be set by clicking on the
respective box

Output can be specified as
GeoTIFF or BEAM-DIMAP

Save graph in a folder.

The graph can be used with other
images

Replace the input and output
paths with Sinfile and $ouffile,
respectively

m Graph Builder : Day1.xml

File Graphs

ThermalNoiseRemoval

Read Write Apply-Orbit-File Speckle-Filter Calibration ThermalNoiseRe

Target Product

Name:
Dec2016_Orb_Spk_Cal_TC_dB

Save as: BEAM-DIMAP Pv

Directory:
F:\Sentinel_Ke\Day 1\Output

Open in SNAP

moval Terrain-Correction LinearToFromdB

@l Help

['f.'-\ un



Sentinel processing - Alaska Satellite Facility

http://hyp3.asf.alaska.edu/
UAF ALAskA SATELLITE FAciLITY

Making remote-sensing data accessible since 1991

A Home ~ Subscriptions One-Time Processing Products ~ L mubea ~

Terrain Correction Change Detection INSAR

Radiometric correction involves removing the Change Detection is a technique that detects which Interferometric synthetic aperture radar (INSAR), is a

misleading influence of topography on backscatter areas have changed between two synthetic aperture radar technique using two or more synthetic aperture
values. Terrain correction is the process of correcting radar scenes. The unique properties of SAR can radar (SAR) images to generate maps of surface

geometric distortions that lead to geolocation errors. detect changes that aren't easily visible in optical deformation or digital elevation, using differences in

imagery. the phase of the waves returning to the satellite or
View details » aircraft.

RTC SAR Data Processing

Radiometrically Terrain Correct large amounts of SAR data quickly on our
¢ servers.

@000



http://hyp3.asf.alaska.edu/

USGS Home

Obtain SRTM Digital Elevation JHE e @ S uses
Model (DEM) - USGS Explorer

Home 1 New System Message Login Register YL Feedback Help‘

DataSein || Addtionak Catinias | RRlesults Search Criteria Summary (Show) Clear Criteria
1. Enter Search Criteria

o GO tOZ httDS :/ / ea I’th eXD I orer.u qu . QOV/ To narrow your search area: type in an address or place | 3 : :'::-. : . (02* 56' 51°S, 038° 3' 4' ) Options ~ Overlays

name, enter coordinates or click the map to define your

search area (for advanced map tools, view the help

o Reg|Ster to be able to download data documentation), and/or choose a date range.

I . oy N “ ” Path/Row | Feature
* In "Search Criteria” tab clicke “Use Map | [

« Click “Clear Coordinates” i e

Predefined Area
« Generate polygon on map with clicks. ——
° GO to ”Data SetS” tab 1. Lat: 04° 11' 58" S, Lon: 039° 02' 18" E 7R
2. Lat: 04° 50'44" S, Lon: 039° 03' 38" E /R
» Select type of data needed. SRTM in “Digital |, L. oes0ees tomo 35 36 =
Elevation” than “SRTM” Use the “SRTM 1 e %

Arc-Second Global”. Note the future [on e | Al Goceit | G Gocrai|
NASADEM will not work for that purpose.

» Click “Results” and select files for download. = searcnfrom:[eioness |¢ﬂ‘°'|°3’3”2°°° =

Search months: (all)

SRTM1SO5E039V3

SERVIR u; Coordinates: -5, 39

The up-to-date Google map is not for purchase or for download; it is to be used as a guide
for reference and search purposes only.


https://earthexplorer.usgs.gov/




Mapping mangrove canopy structure

« Forest structure can be described: spatial extent, tree cover, canopy height and above
ground biomass (AGB).

 Tree cover, canopy height and above ground biomass (AGB) are correlated.
 Different Radar parameters are used to estimate AGB and forest canopy height.
* A generic formulation relating radar backscatter to AGB is:

d°(dB) =a+ b X Log (AGB)

Where a and b are determined by the user from in situ data

* In wet tropical forests, values are about -22.5 and 3 for a and b respectively.

* The values for mangrove forests can change significantly: large variation in structure,
species and the inundation state

* The longer the wavelength (equivalent to lower frequency), the larger is the biomass
saturation point.

« Approximate mangrove backscatter values (co) range from 200, 100, 50, 25 for P, L, C
and X respectively.



Mapping mangrove canopy structure

The observed backscatter (co) reduces dues to absorption by the dense aerial root

especially for HV polarization.

Observation of scrub mangroves at HH and VV display high backscatter (co) due to
iIncreased penetration within the canopy and double-bounce interaction with the water
surface

It is recommended to use a combination of datasets from different sensing technologies to
map mangroves.

Land cover classification can be performed with the radar backscatter as one of the layers

along with data from optical instruments such as Landsat.

One can build upon existing global maps of mangrove extent



Mapping mangrove canopy structure

* Radar backscatter at L band HH acquired by ALOS-2 over the
Gabon Estuary, Gabon. Bright areas to the North West result
from strong double bounce effect in urban structures of the
city of Libreville.

* Large medium backscatter (mid-gray tones) are due to volume
scattering in forests. Water was easily masked based on
darker backscatter (in particular at LHV).

* Interestingly, due to strong attenuation from roots, tall
mangrove forest with red mangrove trees reaching several
tens of meters exhibit lower backscatter along the South
Eastern portion of the Estuary.



Mapping mangrove canopy structure

Significant advances in the use of Radar interferometry to map mangrove canopy height.
Data from the Shuttle Radar Topography Mission has been used to measure canopy height

SRTM was designed to measure elevation, but due to the interaction of the radar
microwave with the canopy volume, the SRTM elevation measurement is biases for forest

height and density.
SRTM helps determine patterns of mangrove height at the landscape to global scales

New elevation measurements derived with interferometric data acquired by TanDEM-X

(e.g. World DEM ) providing a second and more recent dataset.

TanDEM-X elevation datasets are currently available through a proposal process or can be

purchased. htips://tandemx-science.dIr.de/



https://worlddem-database.terrasar.com/
https://tandemx-science.dlr.de/
https://tandemx-science.dlr.de/

Mapping mangrove canopy structure

* Interferometric radar coherence obtained from ALOS-
2 LHH.

* The bright areas represent coherence close to 1
indicating strong similarity between images collected
successively after 24 days.

* These are observed in shrub mangrove as well as in
urban areas.

* Tall mangrove trees exhibit lower coherence due to
temporal decorrelation caused by scattering in the
canopy which changes between the two radar
acquisition (i.e. 24 days in this case).

* Open water surface also displays low coherence due
to waves constantly changing surface scattering.




Mapping mangrove canopy structure

Mangrove height (m)

* Map of mangrove canopy height in the Guayas
Estuary of Ecuador obtained from SRTM
elevation data, calibrated with in situ field data.




Above Ground Biomass Allometry

Tree Allometry for Aboveground Biomass Estimation

Above Ground Biomass Density (AGBD) = Vol 4 x W

2
AGBD =~ S P2 gy,
AL 4
1 < pD;
Vol = — “H.

a2 3 H

A: Area sampled

D: Diameter at Breast Height, DBH

H: Tree Height

T: Tapering Factor (species dependent) AT T
W: Wood Density (species dependent) Wood density decreases as a function of tree height

Water content(dielectric constant) increases as a function

- of tree height
Siqueira — NISAR Ecosystems Lead



Radar Sensitivity to Biomass

-12 T T T T
X
T Characterizing the Effects of
5 Climate Change and Land Use
g -16
%’ \
3 -18 High Priority Fusion Region
= Lower to no sensitivity of radar
E -20 Domain of data fusion and synergism
(¢p) e Mbam Djarem, Cameroon with GEDI and BIOMASS
9 + Barro Colorado, Panama
< 2 X m Pearl River, Louisiana 1
X% % La Selva, Costa Rica
-24 1 1 1 1
0 100 200 300 400 500

LHV (dB) =-22.5 +3.0Log(AGB) Aboveground Biomass (Mg/ha)

Biomass < 100 Mg/ha

Low Priority Fusion Region
Higher sensitivity of radar
Domain of NISAR Performance

Global Biomass Product must be derived from Fusion Approach
For low biomass density (100 Mg/ha) radar sensitivity is high but impacted by structure & environment
For high biomass density ( >100 Mg/ha) data fusion with GEDI and/or BIOMASS required

Siqueira — NISAR Ecosystems Lead



Using QGIS to estimate mangrove biomass

* Two methods
* Using Canopy height from SRTM
* Could also be TanDEM-X or lidar data or stereophotogrammetry

e Using radar backscatter
* From previous exercise



Read and Display SRTM DEM in QGIS

* Drag and drop the DEM (default
tif format) into QGIS.

* Go to “properties” by right
clicking on DEM file name in
QGIS->"Transparency”-
>”"Additional value”=0

* Set background as Google
Satellite using the “XYZ Tiles”
setup.

* Drag and drop available bands in
QGIS to set which is on top or
below.

* To select an area of mangroves,
open vector file.

@ ows

& ArcGisMapServer
& ArcGisFeatureServer
sf¢ GeoNode

06 Layers
« @ ® TV &y @ A 0

,/ Layer Properties - s05_e039_1arc_v3 | Transparency

¥ Global transparency ¥ No data value

=} X No data value: -32767

None 3% Full Additional no data value 0

¥ Custom transparency options

Transparency band None
'. Histogram

Transparent pixel list

v " s05 039 1arc v3
o
464
v [ ¥ Google Satellite Hybrid

Coordinate [ 4384869,-557626 | 9 | Scale[1:352,545 || @ | Magnifier [100% |©) Rotation [0.0° |C) 2 Render| @ EPsG:38s7 || @

’i Metadata

‘ From | To | Percent Transparent







Course outline: Day 2

09:00 -10:00 Session 3b Biomass estimation

10:00 —10:30 Tea/Coffee Break

10:30-12:30 Session 3¢ Biomass estimation

12:30 — 14:00 Lunch Break

14:00 — 16:00 Session 4 Monitoring mangrove loss and gain

16:00 —16:10 Tea/Coffee Break



Read, load and use polygons to cut a raster in QGIS

1. Drag and drop shapefile into QGIS # Clpper .
CREE i "
2. Change colors within polygons with a right rptie e e s tere i A 3
CI i Ck_>” P ro pe rti eS Output file R_Mangrove/Output/DEM_mangrove.tif Select... > gg::;js | » : 4
No data value |0 E o K <
. Man 4 olygon
3. Cut SRTM DEM with polygon Ciping mode overé 9 fonpSRVTgM ot
« Top menu “Raster’->"extraction”->"Clip - o ;
Raster by MaSk Layer” Mas(k:layter 1grovtes/:frllc:_r:andgrove_vnthlndem.shp v Select... 4 i
. . : reate an output alpha ban
° If QGIS falIS IN Cuttlng the SRTM DEM’ you Crop the extent of the target dataset to the extent of the cutline
may need use a Clommand. Iine SUCh aS @ Keep resolution of input raster Set output file resolution
(copy from QGIS into terminal. The =22
shapefile directory did not come up right in XXX

this execution): gdalwarp -ot Float32 -of GTiff szxae

-tr 0.00027778 -0.00027778 -tap -cutline

/YourDirectoryWithShapeFile/africa

e_withindem.shp -crop_to cutline -dstnodata

0.0 / YourDirectoryWithSRTM

/s05 e039 1arc v3.tif/
YourDirectoryWithOutputs

/s05 e039 1arc v3 mangroves.tif

4. You now have a canopy height map. It is
SRTM, the height correspond to basal area
weighted height (also called Lorey’s height).

mangrov

gdalwarp -q -cutline ¢
C:/SAR_Mangrove/Mangroves/africa_mangrove_withindem.shp -tr *
0.000277777777778 0.000277777777778 -of GTiff
C:/SAR_Mangrove/DEM_SRTM/s05_e039_1arc_v3.tif
C:/SAR_Mangrove/Output/DEM_mangrove.tif

The maximum height is generally 1.6X this L SRTM DEM within mangrove

value. (Simard et al., 2018)

forest only.

ies removed. Coordinate [4383088,-537682 | % | Scale[1:107,985 [~] & Magnifier [100% ) Rotation [0.0° |©) @ Render| @ epsG:38s7 || @




Estimation of Above Ground Biomass with Generic Allometric Equations

1. Generic equation relatin g SRTM to canopy height and aboveground
biomass (Simard et al., 2018):
» Basal area weighted helght Hba~ 1.08*SRTM
* Maximum canopy height H,, ., ~ 0.93*1.7*SRTM
« Aboveground Biomass —AGB, B ~ 3.25*H,,'°3

2. Generic equation relating aboveground biomass B in tons per
hectare (t/ha) to backscatter in decibels (dB):
* 5%,,(dB)~ -22.5 + 3.0 * In(B)
. 5°,,(dB)~A.B? (1-eP) + C, with A=0.013682, a=0.21116, D=0.0518486,

C= O 02192 (Yu & Saatchi, 2016). To simplify: B = exp( O. 038 SOy 3 + 1 6089
SOy 2 + 23.007 s°, + 112. 28)

* 3%,/ 0.013682

* Note: There is no definite relationship for mangrove because of water
presence and also increased absorption by roots at high biomass levels, but
the shape of the logarithmic shape remains.



Applying the Generic Height-Based Allometric Equation

* In QGIS, click on “Raster” in the top
menu, then "Raster Calculator” DOBBREO SRS 0D %000 S & ki€

p<X5)

* Define output layer filename, location == ::=

Home

and format (Geotiff is a favorite) T
- Enter allometric equation for SRTM ="

B=3.25*H,, 53, where H,, = 1.08*SRTM:::

rrrrrrrrrrrrrrr
ArcGisFeatureServer

. 3¢ GeoNode ‘ < . xmin [39.09000 |0 xwvex [30.87a72
The equation becomes . em—

Columns [2825 |©) Rows [a602

3.25%(1.08*SRTM)'-52 o

(V] Add result to project

tan | [ log10 | [ (]
atan J L In | () )

DEM_mangrove AGB

[ cancel | [ oK

1 legend entries removed. Coordinate | 4389259,-502292 & Scale|1:107,985 lﬂg ifier [100% | Rotation ® Render| & EPSG:3857 B
B




Applying the Generic Height-Based Allometric Equation

QGIS

o [V e
ECN-F

Browser

Favorites
Home o

/ ' b R
/Volumes 8> # .
@ GeoPackage . £ ek
e

/ Spatialite T

@ PostGls Majoren " ¥ \ = Funzi Island
P mssaL - S

@8 os2

@ wMs

& XYZ Tiles

@ wces

) OWS

& ArcGisMapServer
&> ArcGisFeatureServer
sf¢ GeoNode

Wagld/sland.

w

L

o (5] Laye}s
& ® T &Sy B & O
" s05 €039 1arc_v3_mangroves AGB
0
50
M 100
W 150
v (V) B s05_e039_1arc_v3_mangroves
S 0
| Color | Label :
6
| K]
N2
| K
O
[
1 W
464
v ] B Google Satellite Hybrid

L Type to locate 1legend entries removed. Coordinate [4366098,-537682 | % | Scale[1107,985 ~] @ | Magnifier[100% (2] Rotation [0.0° () @) Render| @ EPSG:a857 | @




1. Upload either the Radar images
generated with through SNAP
processing in dB, or the ALOS-
PALSAR mosaics.

* Note that in the mosaics, the digital
number (DN) value of the pixel must
be transformed to dB using the
following JAXA-provided formula:

* SOH\/(dB) = 20*|Og10(DN) — 83

2. In top menu, click "Raster”, then
“Raster Calculator”.

3. Enter formula in "Raster
Calculator Expression”. Double-
click on band name to insert In
expression.

ALOS PALSAR mosaic SO4E039 _16_MOS_FO02DAR
Dar es Salaam, Tanzania

Favorites

““““““““““““
@ WMS

&Y ArcGisMapServer
& ArcGisFeatureServer
3¢ GeoNode

4= e _ Mangrove polygon(2000) overlaid on
L % ¥ @7  ALOS-PALSAR mosaic in dB for 2007

1legend entries removed.

Scale[1:107,985 [~] & | Magnifier [100% (I Rotation [0.0°  |(Z) @ Render| @ EPSG:3857

-]



Convert digital number (DN) value to dB - backscatter

Z Raster calculator

Raster bands

DEM_mangrove@1
DEM_mangrove_AGB@1
S04E039_16_sl_HV_F02DAR@1
africa_mangrove_withindem@1
s05_e039_larc vi@1

¥ Operators

+ =
/
< >

Raster calculator expression

20* log10 ( "S04E039_16_s|_HV_F02DAR@1")-83

Expression valid

sqrt

Result layer

Output layer ut/S04E039_16_sl_HV_backscatter

Output format GeoTIFF

Current layer extent

X min 38.00086 = XMax  40.00014
Ymin  -5.00014 = Y max  -3.99986
Columns ' 3601 = Rows 3601

Output CRS Selected CRS (EPSG:4326, WGS 84)

X Add result to project

cos sin tan log10

acos asin atan In

= = o= AND
oK

7’ @ Q‘Iﬁ

X

<0

Vo £

N

Q06 Browser

— I & VT ®* O
Favorites
> Home

/

> /Volumes

v

@& GeoPackage

/ SpatiaLite

@ postcls

P mssaL

DB2

& WMS
> & XYZ Tiles

@ wes

V) WFS
ows
ArcGisMapServer
ArcGisFeatureServer
( < GeoNode

4r 4F 4

) @

OR

06 Layers
iy @ &

v @ & Y

W 20
-10
¥ s04£039_07_sI_HV

4 vwYyyw

Cancel -
464

Formula: 20*log4o(DN) — 83

v B Google satellite Hybrid

Y ™

] africa_mangrove_withindem
v [v] [ S04E039_07_sI_HV_bcksctr

s05_e039_1arc_v3_mangroves_AGB
s05_e039_1arc_v3_mangroves

1legend entries removed.

ALOS PALSAR mosaic SO4E039 _16_MOS_FO02DAR
Dar es Salaam, Tanzania

QGIS

Mangrove polygon(2000) overlaid on
ALOS-PALSAR mosaic in dB for 2007

Coordinate | 4371583,-537567 |% Scsle‘1:107,985

]v\ - Magnifier@ Rotation |§\ (V] Render| @ EPSG:3857 || @




In top menu, click on "Raster” and 0.5*10*(40.2*107("S04E039 _16_sl HV backscatter"/10))
then “Raster Calculator”. Enter f -

allometric equation in “Raster L LTERLYF
Calculator Expression”, i.e. Sevae
0.5*1(Q(40.2""Rasterimage”) \yjjth S

“Rasterlmage” in linear unit (m?/m?). ;=

That means if your equation, if using =

> & XYZ Tiles

a dB image, becomes: =

ows

0.5*1 0(40.2*1 07 ("Rasterimage”/10))

& ArcGisFeatureServer
3¢ GeoNode

- % ¥ DEM mangrove AGB

4.03 00 —
49.1 § % T &y @ O
94.3 ] africa_mangrove_withindem
139 v [/ B s04£039_07_sI_HV_bcksctr
'.185 - ,

-1 % E% S04E039_16_sl_HV_backscatter_AGB — 7 g R
0.00536836 M- - e RN ¥ : Mangrove polygon(2000) overlaid on
15.6104 » [/ B s05_e039_1arc_v3_mangroves o | 2 . .

- B s04£039_16_sl_HV_backscatter v e ALOS-PALSAR mosaic in dB for 2007

. -38.8956 464
-11.1129 v (] B Google Satellite Hybrid

- ®® s04E039_16_s| HV_FO2DAR

. 162

. £
&

1legend entries removed. Coordinate [ 4371583,-537567 | ¥ | Scale [1:107,985 v @ | Magnifier [100% () Rotation [0.0° () () Render| @ EPSG:3857 || @




5. Use same mangrove polygon file
used with SRTM to extract the
mangrove extent. Use QGIS
(currently not working in 3.0 and 3.2)
or copy/paste to your terminal
window. E.g. gdalwarp -ot Float32 -of
GTiff -tr 0.0002222 -0.0002222 -tap -
cutline
/DirectoryWherePolygonlLocated/afri
ca_mangrove_withindem.shp -
crop _to cutline
/DirectoryWhereBiomass Transforme
dimagelsLocated/S04E039 07 sl H
V' _bcksctr AGB.tif
/YourOQutputDirectory/S04E039 07 s
| HV bcksctr AGB _mangroves.tif

Mangrove polygon(2000) overlaid on
ALOS-PALSAR mosaic in dB for 2007

Untitled Project - QGIS
— ~ ¢ —
> %] £ y i.d :Qg N7 %4 4 Yeus(o) foso| ‘%% 2 My g T

RV ERE

v :" S04E039 07 sl _HV_bcksctr AGB_mangr...

Magnifier [100% @ RRRRR ion @ [V Render| € EPSG:4326 | @




Applying the Generic Backscatter-Based Allometric Equation

.\-:

S04E039 07 sl HV_bcksctr AGB_mangroves.tif overlay
on Google satellite

* This is the resulting aboveground
biomass map for mangrove areas,
based on the backscatter curve. 0

* The retrieved biomass is much lower
than that obtained with SRTM.

« Backscatter is known to be limited in
mangrove forest, changing with water
level and mangrove types, sometimes
decreasing at biomass above 100t/ha
In red mangroves.

L L L L L L bbb L Lk
FEFEIFEEORE

NN
88 229g

ocate (38K) | 11egend entries removed. Coordinate [ 39.4169,-4.8296 | ¥ | Scale |1: 99999 |vJ & | Magnifier @ Rotation @ V] Render| & EPSG:4326 | | @




Optional: Deriving your own allometric equations

» Obtain field data with latitude, longitude and biomass.
« Make a CSV file.

 Read into QGIS:

 In the top menu: click “Layer’->"Add Layer”-> "->"Add Delimited Text Layer”. Then search your CSV file and
follow instruction. Your may need to specify the projection in “Geometry”.

« If you have installed the QGIS “Point Sampling Tool” plugin, click on its icon and select your CSV layer.

» Select the attributes you want to preserve in the output file.
» These must, of course, include for example biomass and backscatter.

» Define your “Output point vector layer”.
» With the pop-up window, select “Comma Separated Values (*.csv)” as output format.

* Open your new CSV file in Excel and fit equation.

* In QGIS, apply new equation to radar backscatter image using the “Raster Calculator”.

At this point, your can independently generate your own biomass map.

» Using this same method, you can also validate your biomass maps using available field data.






Monitoring mangrove forests loss and gain

* While radar backscatter is not
the best measurement to
estimate biomass in mangrove
forests, one can use it to
monitor mangrove forest loss
and gain through time.

e Use color composite to
visualize changes:

* Load 3 images from different
times into QGIS

* e.g.JERS-1(1996), ALOS-
1(2007) and ALOS-2 (2017)
mosaic tiles.

®0e e *Untitled Project - QGIS
L} 7 /=
.~ ‘@V:‘,

D @ Browser

LY ®* O

"Esr National Geographic

Esri Ocean

Esri Satellite

Esri Standard

Esri Terrain

Esri Topo World

Esri Transportation

Google Maps

Google Satellite

Google Satellite Hybrid
Google Terrain

Google Terrain Hybrid

Open Weather Map Clouds
Open Weather Map Temperature
Open Weather Map Wind Speed
OpenStreetMap
OpenStreetMap H.O.T.
OpenStreetMap Monochrome
OpenStreetMap Standard
Stamen Terrain

Stamen Toner

(&

LLLLLLL]

Parameters  Log |

Input layers

0 elements selec

Resolution

[ highest <)

(] Place each input file into a separate band
(] Allow projection difference
v Advanced parameters
(] Add alpha mask band to VRT when source raster has none
Override projection for the output file [optional]
Proj : EPSG:4. - 2
Stamen Toner Light ce, | | Project CRS: EPSG:4326 - WGS 84 B
Stamen Watercolor L k 4 bz - | Resampling algorithm
Strava All @0 e Multiple selection 2)

Strava Run

LLLLLLLLLLLLLLLL]

oo e (¥) S04E039_07_sI_HH_dB [EPSG:4326] ( OK ]
[xXs] Layers S04E039_17_s|_HH_FO2DAR [EPSG:4326] ( ’|

7 " ) Cancel 3/SO4E039_composite_960717.vrt
o & ® T = e (/) S04E039.17_s| HH_FO2DAR dB [EPSG:4326] L___ance. ___IJy P |
(V] S04E039_96_s| HH_dB [EPSG:4326]

(7) P P m
(v] africa_mangrove_withindem

v (/] B S04E039_17_s|_HH_FO2DAR_dB
| B
-5
vO R
W 246
62044
v [
| B
-5
v " S04E039 96 sl HH dB
W -2 ] Clear selection |
-5 -
v [ B Google Satellite |__Toggle selection | Cancel

te -a_srs EPSG:4326 -r bilinear -input_file_list /var/folders/jb/
yrocessing_afdf862ed1af412081541c08885b6f78/
Dmac/KENYA/Mosaics/S04E039_composite_960717.vrt

( Select all ]

( Add file(s).

(

AP | U a3 DAt FTUGESSI: | Close | | RuninBackground

Type to locate (38K) No features at this position found.
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* ALOS-2 (2017) mosaic tiles.
« Navigator: Click Raster - >

Miscellaneous -> Build Virtual

Raster

/ Build Virtual Raster (Catalog) ? X

X Use visible raster layers for input

e input direc

Input files

Output file ve/Output/S04E039_HH_stack.vrt Select...

X Resolution Highest h
Source No Data |0
Target SRS Select

X Separate
Allow projection difference

X Load into canvas when finished

[]

gdalbuildvrt -resolution highest -separate
C:/SAR_Mangrove/Output/S04E039_HH_stack.vrt C:
\SAR_Mangrove\ALOS_Mosaic\S04E039_16_MOS_F02DAR\S04E0
39_16_s|_HH_F02DAR C:
\SAR_Mangrove\ALOS_Mosaic\S04E039_10_MOS\S04E039_10_sl L
HH C:

TSAR_Ma ngrove\ALOS_Mosaic\S04E039_07_MOS\S04E039_07_sl |3 ‘
Close Help

N BEBRRKR: O S S

RV A WY
AD m Ll'-‘i T

Browser

LX)
Q@

& Y % @

*Untitled Project - QGIS

a4 .B @ (
B 330 P &4 H

- N v v

% ﬁ T ) T

&% Esn National Geographic
¥ Esri Ocean
¥ Esri Satellite
¥ Esri Standard
¥ Esri Terrain
¥ Esri Topo World
¥ Esri Transportation
F Google Maps
" Google Satellite
F Google Satellite Hybrid
¥ Google Terrain
¥ Google Terrain Hybrid
F Open Weather Map Clouds
F Open Weather Map Temperature
? Open Weather Map Wind Speed
¥ OpenStreetMap
? OpenStreetMap H.O.T.
F OpenStreetMap Monochrome
¥ OpensStreetMap Standard
¥ Stamen Terrain
¥ stamen Toner
¥ stamen Toner Light
F Stamen Watercolor
¥ strava All
F Strava Run
D6 Layers
« & & TV &y B RO
3] africa_mangrove_withindem
v (/] B S04E039_17_s|_HH_FO2DAR_dB
| B
-5
vO R
W 246
62044
v [
W -2
-5
v " S04E039 96_s| HH_dB
| B
-5
v [ B Google Satellite

\Z

&
%

-
|

L

: oo |
Multiple selecﬂon

] S04E039_07_sI_HH_dB [EPSG:4326]
S04E039_17_s|_HH_FO2DAR [EPSG:4326]
S04E039_17_s|_HH_FO2DAR_dB [EPSG:4326]

] S04E039_96_s|_HH_dB [EPSG:4326]

Type to locate (88K)

No features at this position found.

s AL s T R
Coordinate | 39.31414,-4.61896 %J Scale [1:27537 [v] @ | Magnifier [100% @ Rotation @ ® Render| & EPSG:4326

Build Virtual Raster

Parameters  Log |
Input layers

0 elements s

Resolution

[ highest =

(] Place each input file into a separate band
(] Allow projection difference
v Advanced parameters

(] Add alpha mask band to VRT when source raster has none
Override projection for the output file [optional]

| Project CRS: EPSG:4326 - WGS 84 <

| Resampling algorithm

. ox ]

: 3/SO4E composite 717.vrt

[ Cancel | i/soac039 960
im
te -a_srs EPSG:4326 -r bilinear -input_file_list /var/folders/jb/
yrocessing_afdf862ed1af412081541c08885b6f78/
Dmac/KENYA/Mosaics/S04E039_composite_960717.vrt

( Select all ]

| Clear selection |

I} Toggle selection |

[ Addfile(s).. |

[ OS] Ui aS DAt FTusess | | Close | | Run in Background

F
1
E
B
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 Load the virtual raster into QGIS.
« Change colors using “Properties” Y

AD

by right clicking on the virtual e
raster. “

« If red, change occurred between
you first input band and the
others

:-' oogle Maps
:-' oogle Satellite
:" oogle Satellite Hybrid
= g
. oogle Terrain
:" oogle Terrain Hybrid
:l' Open Weather Map Clouds

Chae B B e e |
ooooogg@rgrygg‘gq

Gl Open Weather Map Temperature

« If green, change occurred only B o vesvr i Vi son

:l' OpenStreetMap H.O.T.

for the 2nd band. i.e. change P e

occurred between band 1 and 2
but change again, may be el

returning to original land cover —————
between image 2 and 3. Oy T ——"

- If blue, there may have been "o
some regeneration. o

v (V] B Google satellite
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Exercise — detect changes in a virtual stack ALOS Mosaic — back scatter values: SO4E039_HH: 07, 10, 16

* Monitor changes, generate your time-
series from either ALOS mosaics or
Sentinel-1 time-series, processed
through SNAP. You can choose the
acquisition dates to correspond to plant
phenology and climatic trends.

S peTe

fof e b \%\» & ] it
Tor ey s L T N e e
; L .

« Convert the images to backscatter values
Hint : Convert DN to db
SOH\/(dB) = 20*|Og10(DN) — 83

In dB values; -20 and -5, and -25 and -10 for HH and
HV respectively

» Have you found significant changes in

mangrove forests for the study region? In the example above, we used ALOS mosaics of HH:
SO4E039 07 MOS, SO4E039 10 MOS,

SO4E039 16_MOS_F02DAR



Monitoring mangrove forests loss and gain

* Determine change areas with simple
thresholds

* In QIGS, use "Raster’->"Raster
Calculator” to compute the difference
between two bands from different years.

You will notice some changes between the two
images. This is the same location over the coast
of Kwale, Kenya. Coordinates: -4.66, 39.279
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Make a polygon of observed change

* In top menu click “Layer”->"Create Layer”->"New
Shapefile Layer”

* Define “Geometry Type” as “polygon”.

* Define output filename in “File Name” and in
“New Field” use whole number. We’'ll use 1 for
change.

* In the “layers” window, click on this new layer

* In top menu click "Layer”->"Toggle Editing”. You
can now add features within the file by clicking in
the top menu “Edit”->"add polygon feature”

* Draw polygon around observed changes in
difference map with mouse click on vertices of
polygon. To close polygon, right click. Don’t forget
to save after you are done (by clicking “Toggle
Editing” again.




Monitoring mangrove forests loss and gain

Make a polygon of observed change

e To populate the polygons with attribute values
containing statistics from the difference image, use
“SAGA” in the toolbox. To see the the toolbox,
click “Processing” in the top menu and then
“Toolbox”. Navigate to “SAGA”->"Vector-Raster”-
>”Raster Statistics for polygons”.

 Compute zonal statistics of the polygon

Click “Processing” in the top menu and then “Toolbox”.
Type Zonal Statistics and it will appear under Raster tools.

,/ Zonal statistics :: Features total: 3, filtered: 3, selected: 0

< 0| & a7V B &L =R
| id Change Areas _min _max _sum _count _mean
T‘ 2 1 2.000000 2.000000 1226.000000 613.000000 2.000000 %
?‘ 3 1 3.000000 3.000000 1464.000000 488.000000 3.000000
?‘ 1 1 1.000000 1.000000 925.000000 925.000000 1.000000
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Use “Raster”->"Raster Calculator” to make a
change map

* The equation can, for example, have the
following form ("SO4E039 07minus96@1"<-
7.0) and ("S04E039 07 sl HH dB@1">-15)

* The logical operators select all values smaller than -
7 (i.e. change) that are above -15 in 2007. The latter
condition removes some water surfaces when using

HH. You can build you own water mask and use it
instead.

* To clean-up the change map, use the
“Maijority Filter” found in “SAGA”->"Raster
Filter”. A filter of radius 1 is sufficient to
remove false changes that may results from
radar speckle noise.

* Try again but filter the radar images with the
“Multidirectinal Lee Filter” found in “SAGA” -
>"Raster Filter”




Upload the Radar images generated
with through SNAP processing in dB
from Sentinel 1 in QGIS.

* Note that in the mosaics, the digital

number (DN) value of the pixel must be
transformed to dB using the following
JAXA-provided formula:

i GOHv(dB) = 20*|0g10(DN) - 83

In top menu, click "Raster”, then
“Raster Calculator”.

Enter formula in “Raster Calculator
Expression”. Double-click on band
name to insert in expression.

v (/) [ s04E039_07_sI_HV_bcksctr
W 20
-10
» () B s04E039_07_sI_HV
» (/) B s05_e039_1arc_v3_mangroves_AGB
> :-' s05_e039_1arc_v3_mangroves
-

o
W
464
v [/ ¥ Google Satellite Hybrid

1legend entries removed.

Mangrove polygon(2000) overlaid on
Sentinel mosaic in dB

Coordinate | 4371583,-537567 |% Scale‘1:107,985

lv\ - Magnifier@ Rotation |§\ (V] Render| @ EPSG:3857 || @
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